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1 Informaţii
 importante 

Îngrijirea produsului 
Traducerea acestui document este doar pentru 
referintă. 
În cazul în care apar nepotriviri între versiunea în 
Engleză şi versiunea tradusă a acestui manual, 
versiunea în Engleză este considerată cea corectă. 

Atenţie 

Pentru a evita stricarea sau funcţionarea 
defectuoasă: 
Nu expuneţi acest produs la căldură excesivă 
cauzată de echipamente sau lumina solară directă. 
Nu scăpaţi produsul din mînă şi nu lăsaţi alte 
obiecte să cadă pe acest aparat. 
Nu lăsaţi produsul să intre în contact cu apa. Nu 
expuneţi mufa de la căşti sau compartimentul 
pentru baterii la apă, deoarece apa poate cauza 
defecţiuni majore. 
Telefoanele mobile active din vecinătate pot 
cauza interferenţe. 
Salvaţi-vă fişierele! Asiguraţi-vă că aveţi copiile 
originale ale fişierelor downloadate pe acest 
player. Philips nu este responsabil pentru orice 
pierdere de informaţii în cazul în care aparatul se 
strică. 
Gestionaţi-vă (transferaţi, ştergeţi, etc.) fişierele de 
muzică doar cu software-ul furnizat pentru a evita 
apariţia de probleme. 
Nu folosiţi agenţi de curăţare care conţin alcool, 
amoniu, benzen sau substanţe abrasive deoarece 
acestea pot strica aparatul. 

Despre temperaturile de stocare şi operare 
Folosiţi aparatul în spaţii unde temperatura este 
curpinsă între 0 şi 35ºC (32 şi 95ºF). 
Stocaţi aparatul în spaţii unde temperatura este 
cuprinsă între -20 şi 45ºC (-4 şi 113ºF). 
Durata de folosire a bateriei este scurtată la 
temperaturi mici. 

Accesoriile/părţile de schimb: 
Vizitaţi www.philips.com/support pentru a 
comanda accesorii sau părti de schimb. 

Siguranţa auzului 

Ascultaţi la volum moderat 
Folosirea căştilor la volum mare poate duce la 
pierderea auzului. Acest aparat poate produce 
sunete puternice ce pot cauza pierderea auzului 
pentru o persoană normală, chiar şi la o expunere 
de mai puţin de un minut. Aceste sunete sunt 
oferite pentru persoanele care au deja probleme 
cu auzul. 
Sunetul poate fi înşelător. Cu timpul, “nivelul de 
confort” al auzului se adaptează la sunete mai 
puternice. Deci, după o periodă mai lungă, ceea 
ce pare normal poate fi tare şi dăunător pentru 
auz. Pentru a preveni acest lucru, setaţi volumul la 
un nivel sigur înainte ca auzul să se adapteze. 
Pentru a stabili un volum de ascultare sigur: 
Daţi volumul la un nivel mic. 
Măriţi uşor nivelul volumului pînă ce auziţi clar şi 
confortabil, fără distorsiuni. 
Ascultaţi pentru perioade rezonabile de timp: 
Expunerea prelungită la sunet, chiar şi la nivele 
“sigure”, poate duce la pierderea auzului. 
Asiguraţi-vă că folosiţi echipamentul rezonabil şi 
că luaţi pauze. 
Citiţi următoarele reguli înainte de a folosi căştile: 
Folosiţi aparatul pentru perioade de timp 
rezonabile şi la volum sigur. 
Aveţi grijă să nu reglaţi nivelul volumului în timp 
ce auzul se adaptează. 
Nu daţi volumul atît de tare încît nu mai auziţi ce 
se întîmplă în jurul dvs. 
Nu folosiţi acest aparat sau căştile în situaţii 
potenţial periculoase. 
Nu folosiţi căştile în timp ce conduceţi, mergeţi cu 
bicicleta, etc; acest lucru poate cauza accidente în 
trafic şi este ilegal în multe zone. 
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Modificări 
Modificările neautorizate de către fabricant pot 
duce la pierderea dreptului de a folosi acest 

Informaţii privind drepturile de autor 
Toate numele de mărci şi produse sunt mărci 
înregistrate ce aparţin de companiile şi 
organizaţiile respective. 
Duplicarea neautorizată a înregistrărilor, fie ele 
downloadate de pe Internet sau copiate de pe un 
CD audio, este o violare a drepturilor de autor şi 
a tratatelor internaţionale. 

 A face copii neautorizate a materialelor 
protejate, inclusiv a programelor de calculator, 
fişierelor, transmisiilor şi înregistrărilor de sunete, 
reprezintă o încălcare a drepturilor de autor şi 
este un act criminal. Acest echipament nu trebuie 
folosit pentru astfel de scopuri. 
Windows Media şi logo-ul Windows sunt mărci 
înregistrate ale Corporaţiei Microsoft din Statele 
Unite ale Americii şi/sau din alte ţări. 

Fiţi responsabili! Respectaţi drepturile de autor. 

Philips respectă proprietatea intelectuala a altora, 
şi cerem utilizatorilor noştrii să facă acelaşi lucru. 
Conţinutul multimedia de pe Internet este posibil 
să fi fost creat şi/sau distribuit fără consinţămîntul 
proprietatului de drept. 

Copierea şi distribuirea conţinutul neautorizat 
poate viola drepturile de autor din diverse ţări, 
inclusiv a dvs. 

Înţelegerea şi respectarea drepturilor de autor 
rămîne responsabilitatea dvs. 

Puteţi înregistra sau transfera fişiere video cu 
conţinut licenţiat downloadate de pe Internet 
către player-ul dvs. Puteţi folosi acest conţinut 
doar pentru scopuri private, non-comerciale şi 
trebuie să respectaţi eventualele drepturi de 
autor care sunt oferite cu fişierele. Instrucţiunile 

pot cere să nu se mai facă copii dupa fişiere. 
Stream-urile video pot avea încorporate 
tehnologie de protecţie împotriva copierii. Pentru 
astfel de situaţii, funcţia de înregistrare nu va 
funcţiona şi veţi fi anunţat printr-un mesaj. 

Arhivarea datelor 
Philips şi-a luat responsabilitatea să 
îmbunătăţească calitatea produsului şi experienţa 
utilizatorului. Pentru a înţelege profilul de utilizare 
al acestui produs, dispozitivul are salvat anumite 
informaţii în regiunea memoriei non-volatile. 
Aceste informaţii sunt folosite pentru a identifica 
şi detecta orice probleme care pot apărea în 
timpul utilizării. Informaţiile salvate, de exemplu, 
vor fi durata de redare în modul muzică, durata 
redării în modul tuner, de cîte ori a rămas 
dispozitivul fără baterie, etc. Aceste informaţii nu 
afişează conţinutul fişierelor salvate sau sursa 
acestora. Informaţiile de pe dispozitiv sunt 
recuperate doar dacă utilizatorul returnează 
dispozitivul la un centru Philips şi doar pentru a 
simplifica modalitatea de detectare şi prevenire a 
problemelor. Informaţiile salvate pot deveni 
disponibile doar la cererea utilizatorului. 

Decodor Monkey Audio 
Codul sursă şi Monkey Audio SDK pot fi utilizate 
pentru adăugare la formatul de redare APE, 
pentru codare sau suport de etichetare a oricărui 
produs, gratis sau comercial. Utilizarea codului 
pentru eforturile de proprietate care nu suportă 
formaul APE oficial necesită consinţămînt scris al 
proprietarului. 
Sursa Monkey Audio poate fi inclusă în GPL sau 
sursa de software deschisă, chiar dacă Monkey 
Audio nu este subiectiv la cerinţele externe 
pentru licenţiare şi a altor restricţii a surselor 
virale. 
Schimbările şi îmbunătăţirile codului trebuie 
contribuite înapoi la proiectul Monkey Audio, 
liber de restricţii, decît dacă acestea sunt 
exprimate în scris de către autor. 
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Orice cod sursă, idei sau librării media folosite 
trebuie recunoscute de către software prin 
folosirea codului. 

Chiar dacă software-ul a fost testat, autorul nu 
este responsabil pentru stricăciunile provocate 

 

de către folosirea defectuoasă sau problemelor 
apărute. 

Dacă nu sunteţi complet de acord cu prevederile 
anterioare, nu mai folosiţi codul sursă şi ştergeţi-l 
din dispozitiv. 

Decodor FLAC 
Drept de autor (C) 
2000,2001,2002,2003,2004,2005,2006,2007,2008,
2009 Josh Coalson 

Redistribuirea şi utilizarea în formă binară sau 
sursă, cu sau fără modificări, sunt permise atît 
timp cît următoarele condiţii sunt îndeplinite: 

Redistribuirea codului sursă trebuie să aibă ataşată 
cerinţa privind drepturile de autor de mai sus, 
aceasta listă de condiţii şi următoarea regulă: 
Redistribuirea în formă binară trebuie să 
reproducă nota privind drepturile de autor de 
mai sus, lista de condiţii şi următoarea regulă din 
documentaţie şi/sau alte materiale oferite. 
Nici numele Xiph.org Foundation nici numele 
contribuitorilor nu pot fi folosite pentru a 
promova sau vinde produse derivate din acest 
software fără consinţămînt în scris. 

ACEST SOFTWARE ESTE OFERIT DE CĂTRE 
DEŢINĂTORII DE DREPTURI DE AUTOR ŞI 
CONTRIBUITORI “DREPT” ORICE GARANŢIE 
EXPRIMATĂ SAU IMPLICITĂ, INCLUSIV, DAR 
NU LIMITATĂ, GARANŢIILE IMPLICITE 
PENTRU VÎNDABILITATE ŞI ADECVARE 
PENTRU UN ANUME SCOP SUNT EXCLUSE. 
ÎN NICI UN CAZ FUNDAŢIA SAU 
CONTRIBUITORII NU SUNT RESPONSABILI 

PENTRU ORICE INCIDENT DIRECT, 
INDIRECT, SPECIAL, EXEMPLAR SAU 
CONSECVENŢIAL (INCLUSIV DAR NU ESTE 
LIMITAT, ACHIZIŢIONAREA BUNURILOR DE 
SUBSTITUŢIE SAU SERVICII; PIERDEREA 
UTILIZĂRII DATELOR SAU A PROFITURILOR 
SAU ÎNTRERUPEREA ACTIVITĂŢII) CAUZATE 
ŞI PE ORICE TEORIE A RĂSPUNDERII, DACĂ 
ÎN CONTRACT, RĂSPUNDEREA STRICTĂ, 
SAU DELICTUALĂ (INCLUSIV NEGLIJENŢĂ 
SAU ALTĂ CAUZĂ) SURVENITĂ DIN ORICE 
UTILIZARE A ACESTUI SOFTWARE, CHIAR 
DACĂ S-A AVERTIZAT DE POSIBILITATEA 
ACESTOR STRICĂCIUNI.  

XPAT XML Parser 
Drepturi de autor © 1998, 1999, 2000 Thai 
Open Source Software Center Ltd 
Persmisiunea este oferită, fără cost, oricărei 
persoane care obţine o copie a acestui software 
prin fişierele de documentaţie asociate 
(“Software”), pentru a folosi Software-ul fără 
restricţii, inclusiv fără limitarea drepturilor de 
utilizare, copiere, modificare, îmbinare, publicare,
distribuire, sub-licenţă, şi /sau vînzarea de copii de
Software, atît timp cît următoarele condiţii sunt 
îndeplinite: 
Notă privind drepturile de autor de mai sus şi 
această notă privind permisiunea trebuie incluse 
în toate copiile sau porţiunile substanţiale din 
Software. 
SOFTWARE-UL ESTE OFERIT FĂRĂ 
GARANŢIE, EXPRIMATĂ SAU IMPLICITĂ, 
INCLUZÎND DAR NU ESTE LIMITATĂ DE 
CĂTRE GARANŢIILE PRIVIND VÎNZAREA, 
FOLOSIREA PENTRU UN ANUMIT SCOP. ÎN 
NICI UN CAZ AUTORII SAU PERSOANELE 
CARE DEŢIN DREPTURILE DE AUTOR NU 
VOR FI ŢINUTE RESPONSABILE PENTRU 
DESPĂGUBIRI, SAU ORICE ALTĂ CERERE, 
PRIVIND O ACŢIUNE DIN CONTRACT SAU 
TERŢĂ, CU SAU FĂRĂ CONEXIUNE LA 
SOFTWARE-UL FOLOSIT. 
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Reciclarea produsului şi bateriei
încorporate 
Acest aparat este fabricat din materiale şi 
componente de înaltă calitate care pot fi reciclate 
şi reutilizate. Nu debarasaţi acest aparat cu 
deşeurile menajere normale. Vă rugăm să vă 
informaţi despre legile locale privind colectarea 
separată a aparatelor şi bateriilor vechi. 
Debarasarea corectă va duce la prevenirea 
consecinţelor potenţial negative asupra mediului 
înconjurător dar şi asupra sănătăţii umane.  
Vă rugăm vizitaţi www.recycle.philips.com pentru 
informaţii adiţionale privind centrele de reciclare 
din zona dvs. 

Avertisment 

 

Pentru produsele cu baterii încorporate care nu 
se schimbă: Îndepărtarea bateriei (sau încercarea 
de a scoate bateria) va duce la invalidarea 
garanţiei. Această procedură trebuie făcută doar 
cînd aparatul nu mai este funcţional. 

Produsul conţine o baterie reîncărcabilă 
încorporată care corespunde cu cerinţele 
Directivei Europene 2006/66/EC. Această baterie 
nu trebuie debarasată cu deşeurile menajere 
normale. 

Pentru a păstra funcţionalitatea şi siguranţa acestui 
produs, duceţi aparatul la un centru de colectare 
oficial sau la un centru service pentru a îndepărta 
sau înlocui bateria cum este prezentat mai jos: 

 
Vă rugăm să vă informaţi despre legile locale 
privind colectarea separată a bateriilor. 
Debarasarea corectă a bateriilor va duce la 
prevenirea consecinţelor potenţial negative 
asupra mediului înconjurător dar şi asupra 
sănătăţii umane. 

Notă pentru Uniunea Europeană 

Aceast produs corespunde cu cerinţele Uniunii 
Europene privind interferenţele radio. 
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Philips GoGear audio player

Quick start guide

Player-ul VIBE
Folosiţi player-ul VIBE pentru a: 

Reda fişierele audio 
Viziona materiale video
Asculta la radio FM 
Înregistra 

Ce găsiţi în cutie 
Verificaţi dacă aţi primit următoarele accesorii: 

Player 

Căsti 

Ghid de instalare rapidă  

Notă 

Imaginile din acest manual de utilizare sunt doar 
de referinţă. Philips îşi rezervă dreptul de a 
schimba culoarea/designul produsului fără 
notificare. 
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Pregătiri 

Prezentarea comenziilor şi
conexiunilor 

Afişaj 
Apăsaţi: măreşte/micşoreaza nivelul
volumului 
Ţineţi apăsat: măreşte/micşoreaza 
repede nivelul volumului 
Afişează opţiunile din meniu 
Ţineţi apăsat: trece la fişierul 
anterior/următor 
În ecranul de redare, ţineţi apăsat 
pentru a scana piesa curentă 
Apăsaţi: redă/întrerupe/confirmă 
Microfon 

Mufă pentru căşti 
Apăsaţi: resetează player-ul 

Ţineţi apăsat: porneşte/opreşte player-ul 
Blochează/deblochează tastele 
În listă, navighează sus/jos 
În listă, ţineţi apăsat, navighează

 sus/jos repede 
Mufă USB 
Apăsaţi, trece la nivelul anterior 
Ţineţi apăsat, trece la meniul
 principal 

Limitarea volumului 

Atenţie 

A asculta la sunete puternice pentru o perioadă 
îndelungată poate duce la pierderea auzului. 

Puteţi limita volumul din player-ul VIBE: 

Din meniul principal, selectaţi [Settings] > 
[Sound Settings] > [Volume limit]. 

Apăsaţi pe tastele             pentru a regla nivelul 
volumului. 

Apăsaţi pe       pentru confimare. 
Cînd setaţi o limită de volum, player-ul 
nu va depăşi această limită chiar dacă 
apăsaţi pe tasta de volum 

Pentru a activa volumul maxim: 
Selectaţi [Settings] > [Sound Settings] > 
[Volume limit]. 

Setaţi nivelul volumului la maxim. 

Apăsaţi pe      pentru confirmare. 
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Music
Rhapsody*
channels
Video
Pictures
FM radio
Recordings

Folder 
view
Settings

Now 
playing

Prezentarea meniului principal 

Meniu Mod Pentru a 
Redă piesele audio digitale 

Ascultă la canalele
Rhapsody* 

Reda fişierele video 
Afişa imaginile 
Asculta la FM radio 

Crea sau asculta înregistrări 

Viziona fişierele din foldere 

Personaliza setările
 player-ului 

Afişa ecranul redării curente 

Notă 

Canalele Rhapsody* vor deveni o parte din 
meniul principal după ce conectaţi player-ul Vibe 
la un calculator care are software-ul Rhapsody 
instalat. Aveţi nevoie de un cont Rhapsody activ. 
Această opţiune este disponibilă doar în anumite 
regiuni. 

Conectare şi încărcare 

Player-ul VIBE are o baterie încorporată care 
poate fi încărcată prin port-ul USB din calculator 
(cablul USB nu este inclus). 

Note 

Cand conectaţi player-ul VIBE la calculator, veţi fi 
rugaţi să selectaţi: 
[Charge & transfer] sau [Charge & play] 
VIBE va selecta automat [Charge & transfer], dacă 
nici o selecţie nu e facută. 

Conectarea player-ului la calculator 

Conectaţi mufa mică din cablul USB la mufa 
din player-ul VIBE. 

Conectaţi cablul USB furnizat la un port USB 
din calculator. 

Porniţi calculatorul. 
Player-ul se va încărca. 

Instalarea software-ului Philips 
Songbirb pentru prima data 

Cînd conectaţi player-ul VIBE la calculator pentru 
prima dată, o fereastră va fi afişată: 

Selectaţi Install Philips Songbird.  

Urmăriţi instrucţiunile de pe ecran pentru a 
completa instalarea. 

Notă 

Pentru a completa procesul de instalare trebuie 
să fiţi de acord cu termeni legali.  

Dacă fereastra nu este afişată automat: 

Selectaţi My Computer (Windows XP / 
Windows 2000) / Computer (Windows 
Vista / Windows 7). 

Click dreapta pe Philips GoGear VIBE. 

Selectaţi Install Philips Songbird (Setup.exe). 

Urmăriţi instrucţiunile de pe ecran pentru a 
completa instalarea. 

Notă 

Pentru a completa procesul de instalare trebuie 
să fiţi de acord cu termeni legali.  
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Reinstalarea software-ului Philips 
Songbird (după prima instalare) 
Important! 
Software-ul Philips Songbird este preîncărcat pe 
player-ul VIBE. 
Pentru a elibera capacitatea memoriei pentru 
conţinutul player-ului VIBE, fişierul software este 
şters automat după prima instalare.  
Dacă doriţi să instalaţi software-ul oricînd (după 
prima instalare), urmăriţi instrucţiunile de mai jos: 

Conectaţi player-ul la calculator. 

Asiguraţi-vă că aţi conectat calculatorul la 
Internet, şi deschideţi Windows Explorer. 

În Windows Explorer, click dreapta pe player-ul 
VIBE, apoi selectaţi opţiunea pentru a instala 
Philips Songbird. 

Calculatorul va downloada fişierul 
de pe Internet. 

Urmăriţi instrucţiunile de pe ecran pentru a 
completa instalarea. 

Indicatorul de energie pentru baterie 

Pe ecran este indicat nivelul aproximativ de 
energie al bateriei: 

Cînd iconita pentru baterie clipeşte înseamnă că 
player-ul nu mai are energie. Setările vor fi salvate 
şi player-ul se va opri după 60 de secunde. 

Note 

Bateriile reîncarcabile au un număr limitat de 
cicluri de încărcare. Viaţa bateriei şi numărul de 
cicluri de încărcare variază în funcţie de setări şi 
de utilizare. 
Cînd iconiţa de încărcare dispare şi cînd iconiţa   
este afişată înseamnă că player-ul este încărcat 
complet. 

Sfat 

Pentru a economisi energie şi a mări timpul de 
redare al player-ului VIBE, treceţi la    > [Display 
Settings] > [Screen off timer] şi selectaţi cea mai 
mică opţiune. 

Software-ul incarcat pe
 player-ul VIBE 
Player-ul VIBE vine cu următorul software: 

Philips Songbird (care vă ajută să vă actualizaţi 
firmware-ul player-ului şi să transferaţi fişierele 
media). 

Fişierele încărcate pe VIBE 

Următoarele fişiere sunt încărcate pe player-ul 
VIBE: 

Manual de utilizare 
Întrebări frecvente şi răspunsuri 
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Actualizarea
 player-ului 

Player-ul VIBE este controlat de un program 
intern numit firmware. Versiuni noi ale acestui 
program pot apărea după ce cumpăraţi acest 
aparat. 
Programul software se numeşte Philips Songbird 
şi se foloseşte de calculator pentru a verifica dacă 
au apărut versiuni de software noi pe Internet. 
Instalaţi Philips Songbird pe calculator şi urmăriţi 
instrucţiunile pentru actualizare (consultaţi 
capitolul “Verificarea / Actualizarea manuală a 
software-ului”). 

Notă 

Fişierele de muzică nu sunt afectate de 
actualizarea software-ului. 

Verificarea / Actualizarea manuală 
a software-ului 

Asiguraţi-vă că aţi conectat calculatorul la 
 Internet. 

Conectaţi player-ul la calculator (consultaţi 
secţiunea “Conectare şi încărcare”). 

Din calculator, selectaţi Start > Programs > 
Philips > Philips Songbird pentru a lansa aplicaţia 
Philips Songbird. 

Selectaţi Tools > Updates. 
Philips Songbird verifică dacă au apărut 
versiuni noi de software pe Internet. 

Urmăriţi instrucţiunile de pe ecran pentru a 
completa actualizarea software-ului VIBE. 

Aşteptaţi pînă ce procesul de actualizare este 
complet, apoi deconectaţi player-ul de la 
calculator. 

Player-ul se va reporni după actualizare. 
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Pornirea şi oprirea
 player-ului VIBE 

Pentru a porni sau opri player-ul, ţineţi apăsat pe   
pentru aproximativ 2 secunde. 

Oprirea automată 

Player-ul VIBE are o opţiune de oprire automată 
pentru a economisi energie. 
După 10 minute în modul Idle, player-ul VIBE se 
va opri. 

Ţineţi apăsat pe     pentru aproximativ două 
secunde pentru a porni player-ul. 

Blocarea tastelor 
Player-ul VIBE are o opţiune de blocare a tastelor 
pentru a preveni operaţiile accidentale. 

Pentru a bloca tastele în timpul redării, mutaţi 
butonul de blocare pe poziţia 

Toate tastele, cu excepţia tastelor de 
volum, vor fi blocate şi pe ecran va fi
afişat o iconiţă lăcăţel. 

Pentru a debloca tastele, mutaţi butonul de 
blocare pe poziţia centrală. 
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VIBE vine cu software-ul Philips Songbird. 
Acest software vă ajută la: 

Cumpărarea fişierelor media (audio sau 
video) online 
Crearea unei librării media 
Gestionarea librăriei media 

Sincronizarea fişierelor media cu player-ul 
Redarea audio si video

Cînd Philips Songbird este lansat pentru prima 
dată, alegeţi una din următoarele opţiuni pentru a 
importa fişierele media către librăria Songbird: 

Import an existing iTunes library (Importaţi o 
librărie iTunes existentă) 
Scan for media files in specific directories. (Scanaţi 
fişierele media din anumite directoare; Puteţi 
selecta să urmăriti un folder astfel încît fişierele 
sunt adăugate sau şterse automat cînd se fac 
modificări în librăria media Songbird). 

Crearea unei librării media 
Folosiţi una din următoarele opţiuni pentru a crea 
o librărie media cu Songbird: 

Copierea unui CD (Rip) 

Drept opţiune originală, software-ul Philips 
Songbird va instala următoarele add-on care sunt 
necesare pentru copierea unui disc: 

Setarea opţiunilor de copiere 

Din calculator, lansaţi programul Songbird. 

Selectaţi Tools > Options … 

Selectaţi căsuţa CD Rip, apoi selectaţi optiunile 
de copiere, 

Apăsaţi pe OK pentru confirmare. 

Importarea fişierelor media 
dintr-un director 

Mai jos sunt prezentaţi paşii pentru importa-
rea fişierelor media (audio şi video) care sunt 
salvate pe calculator sau pe reţea. 

Din calculator, lansaţi programul Songbird. 

Din bara Songbird, apăsaţi pe file, apoi selectaţi 
Import Media … 

Selectaţi fişierele media (audio sau video), apoi 
apăsaţi pe OK. 

Fişierele media adăugate sunt listate
 în librãria media. 

Sfat 

Dacă selectaţi un folder care conţine fişiere video 
sau audio, software-ul va scana folder-ul şi va 
adăuga toate fişierele video şi audio către librăria 
media (titlurile identice sunt ignorate). 

Importarea fişierelor media de pe
 iTunes 

Din calculator, lansaţi programul Songbird. 

Selectaţi Tools > Options … 

Din bara Songbird, selectaţi căsuţa Media 
Importer, apoi iTunes Import/Export. 

Verificaţi locaţia librăriei şi opţiunile.  

Selectaţi Import Library. 
Software-ul importă librăria iTunes către 
Songbird. 
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Exportarea fişierelor media către iTunes 

Din calculator, lansaţi programul Songbird. 

Selectaţi Tools > Options … 

Din bara Songbird, selectaţi căsuţa Media 
Importer, apoi iTunes Import/Export. 

Verificaţi locaţia librăriei şi opţiunile. 

Selectaţi Export Library. 
Software-ul vă exporta librăria din 
Songbird cãtre iTunes. 

Obţinerea conţinutului de la sursele
 online 
Puteţi cumpăra fişiere media de la sursele digitale 
precum: 

Verificaţi specificaţiile player-ului VIBE pentru a 
verifica ce servicii sunt disponibile pentru dvs. 

Importarea înregistrărilor de pe player 
Din calculator, lansaţi programul Songbird. 

Din bara Songbird, apăsaţi pe File, apoi selectaţi 
Import Media… 

Selectaţi înregistrările de pe player-ul VIBE, apoi 
apăsaţi pe OK. 

Înregistrările selectate sunt listate în 
librăria media. 

Sfat 

Dacă selectaţi un folder care conţine înregistrări, 
software-ul va scana folder-ul şi va adăuga toate 
înregistrările în librărie (titlurile identice sunt 
ignorate). 

Navigarea prin librăria media 

Librăria media Songbird este structurată în modul 
următor: 

Player Pane (panoul în care este afişat player-ul 
VIBE). 

Library Pane (panoul în care este afişat conţinutul 
librăriei) 

Service Pane (panoul în care sunt afişate 
informaţii adiţionale despre conţinut, precum 
listele) 

Information pane (panoul în care sunt afişate 
informaţiile despre opţiunile selectate) 

Organizarea şi gestionarea 
librăriei Songbird 

Lăsaţi software-ul Songbird să 
gestioneze fişierele 

Din calculator, lansaţi programul Songbird. 

Selectaţi Tools > Options… 

Din bara Songbird, selectaţi căsuţa Manage 
Files. 

Marcaţi Allow Songbird to manage my files. 

Setaţi opţiunile pentru gestionarea fişierelor 
media. 
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Îndepărtarea fişierelor media din 
librãria Songbird 

În librăria Songbird, click dreapta pe un fişier, 
apoi selectaţi Remove. 

În fereastra nouă, apăsaţi pe Remove pentru a 
confirma îndepărtarea fişierului din librărie. 

Fişierul selectat este îndepărtat din
librărie şi din liste (Fişierul media se 
găseşte în locaţia originală din calcu-
lator sau din reţea). 

Sfat 

Pentru a selecta mai multe fişiere din calculator, 
ţineţi apăsat pe Ctrl. 
Pentru a selecta mai multe fişiere consecutive din 
calculator, ţineţi apăsat şi pe Shift. 

Ştergerea fişierelor media 

Mai jos este prezentat modul în care puteţi şterge 
fişierele media din Windows Explorer. 

Conectati player-ul la calculator. Deschideti 
Windows Explorer. 

Localizaţi folder-ul media din player-ul VIBE. 

Ştergeti fişierul media în acelaşi mod ca şi cum aţi 
şterge fişierele de pe calculator. 

Urmărirea unui folder de către 
programul Songbird 
Puteţi permite programului Songbird să: 

Monitorizeze conţinutul unui folder, şi 
Să adauge fişierele din librărie pentru a 
sincroniza conţinutul 

Din calculator, lansaţi programul Songbird. 

Selectaţi Tools > Options … 

Din bara Songbird, selectaţi căsuţa Media 
Importer, apoi Watch Folders. 

Selectaţi folder-ul pentru urmărirea acestuia cu 
programul Songbird. 

Folder-ul selectat este urmărit şi Songbird 
va potrivi conţinutul librăriei cu conţinutul 
folder-ului. 

Album Artwork 

Alegeţi una din opţiunile de mai jos pentru a 
alege imagini pentru album (Album Artwork). 

Din calculator, lansaţi programul Songbird. 

Din bara Songbird, selectaţi Tools > Get Album 
Artwork. 

Dacă nici un titlu nu este selectat, Songbird 
va alege imagini pentru toate titlurile din 
librărie. 

Click-dreapta pe titlurile selectate. 
Songbird va selecta imagini doar pentru 
titlurile selectate. 
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Liste de redare 

Drept opţiune originală, software-ul Philips 
Songbird va instala următoarele add-on care 
sunt necesare pentru a copia un disc: 

Crearea unei liste 

Din calculator, lansaţi programul Songbird. 

Alegeţi una din următoarele opţiuni pentru a 
crea o nouă listă. 

Din bara Songbird, selectaţi File >
 New Playlist. 
Click-dreapta pe mîna din bara 
laterală şi alegeţi New Playlist. 
Apăsaţi pe simbolul + din partea 
de jos a panoului Service Pane. 

O nouă listă va fi afişată în panoul Service 
pane. 

Introduceţi un nume pentru noua listă. 

Adăugarea titlurilor într-o listă 

Din calculator, lansaţi programul Songbird. 

Selectaţi unul sau mai multe titluri. 

Alegeţi din aceste opţiuni pentru adăuga titlurile 
selectate în lista: 

“Drag and drop” titlurile în lista din 
panoul Service pane. 
Click-dreapta pe selecţie, şi selectaţi 
Add to Playlist > The_name_of_
your_playlist. 
Toate titlurile selectate sunt adăugate în listă. 

Îndepărtarea titlurilor din listă 

Din calculator, lansaţi programul Songbird. 

Selectaţi o listă. 

Click dreapta pe titlul dorit, apoi selectaţi 
Remove. 

Titlul selectat este îndepărtat din listă. 

Schimbarea aspectului librăriei 
Songbird 
Puteţi schimba designul şi schema de culori a 
librăriei Songbird. Acest lucru se numeşte 
“changing feathers”. Noi caracteristici sunt 
instalate şi gestionate precum un add-on. 

Căutarea de caracteristici noi 

Din calculator, lansaţi programul Songbird. 

Din bara Songbird, selectaţi View > Feathers > 
Get More Feathers… 

Software-ul va căuta noi caracteristici. 

Urmăriţi instrucţiunile on-line pentru a instala 
caracteristicile. 
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Formatarea player-ului 
(ştergerea informaţiilor) 
Philips Songbird are o caracteristică Format care 
vă permite să formataţi player-ul VIBE şi să 
ştergeţi toate fişierele din memoria internă. 

Atenţie 

Următoarea procedură va şterge toate fişierele 
de pe player-ul VIBE. 

Instalaţi Philips Songbird pe calculator, apoi lansaţi 
programul. 

În panoul player-ului Philips Songbird, apăsaţi pe 
VIBE. 

În panoul librăriei, click dreapta pe căsuţa Tools. 

În panoul Tools, apăsaţi pe format Device. 

Urmăriţi instrucţiunile de pe ecran pentru a 
completa procedura de reparare. 

Repararea player-ului 
(resetarea opţiunilor) 
Philips Songbird are o opţiune de reparare care 
permite resetarea opţiunilor din player-ul VIBE la 
starea originală. Înainte de a resetare, asiguraţi-vă 
că aveţi copiile originale ale fişierelor de pe player. 

Atenţie 

Următoarea procedură va duce la ştergerea 
fişierelor şi la resetarea opţiunilor din player-ul 
VIBE la starea originală. 

Instalaţi Philips Songbird pe calculator, apoi lansaţi 
programul. 

În bara de meniu Philips Songbird (din partea de 
sus), apăsaţi pe meniul Tools şi selectaţi Repair 
My VIBE. 

Urmăriţi instrucţiunile de pe ecran pentru a 
completa procedura de reperare. 
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Muzică 

A asculta muzică 

Din meniul principal, selectaţi      pentru a 
intra în modul muzică. 

Navigaţi prin sub-meniuri pentru a selecta 
o piesă. 

Apăsaţi pe       pentru a porni sau întrerupe 
redarea. 

Apăsaţi pe       pentru a afişa mai multe 
opţiuni. 
Apăsaţi pe      pentru a trece la nivelul 
anterior. 
Ţineţi apăsat pe        pentru a trece la 
meniul principal. 

Navigarea în interiorul unei 
piese 

În timp ce ascultaţi o piesă, apăsaţi pe 
pentru a naviga înainte/înapoi în interiorul piesei. 

Apăsaţi pe        pentru a viziona mai multe 
opţiuni. 

Redarea audio dintr-o selecţie 
filtrată 

În timp ce ascultaţi muzică, apăsaţi pe      şi 
selectaţi [Play mode] > [Play music from…]. 

Selectaţi filtrul de selecţie (de exemplu, […this 
album] (redă doar muzica din albumul curent). 

VIBE va reda fişierele doar din selecţia 
filtrată. 

Găsirea fişierelor audio 

Din meniul principal, selectaţi     pentru a 
intra în modul muzică. 
VIBE vă oferă următoarele opţiuni: 

[All songs] 
Piesele sunt listate în ordine alfabetică. 

[Artists] 
Artiştii sunt listaţi în ordine alfabetică 
Albumele listate în ordine alfabetică 
Piesele listate în ordine alfabetică 

[Albums] 
Albumele sunt listate în ordine alfabetică 
Piesele sunt listate în ordinea albumelor 

[Album art] 
Imaginile sunt listate în ordine alfabetică. 

[Playlists] 
[Playlist-on-the-go] 
Piesele sunt listate în ordinea listelor 

[Audiobooks]* 
Cărţile audio sunt listate în ordine alfabetică 

Note 

*Puteţi cumpăra cărţi audio de la magazinele 
online precum audible.com 
VIBE redă cărţile audio precum fişierele audio. 

Ştergerea piesei curente 

Mai jos este prezentat cum să ştergeţi piesa 
curentă. 

În timp ce piesa este redată, apăsaţi pe 

Selectaţi opţiunea de ştergere. 

Selectaţi [Yes] pentru confirmare. 
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Ştergerea mai multor piese 

Folosiţi software-ul Philips Songbird pentru a 
sincroniza fişierele media. 
Alternativ, puteţi şterge fişierele cu Windows 
Explorer. 

Conectaţi player-ul la calculator. 

În Windows Explorer, localizaţi folder-ul 
VIBE. 

Ştergeţi fişierele în acelaşi mod cum ştergeţi 
fişierele de pe calculator. 

Notă 

Alternativ, puteţi selecta     din meniul principal 
pentru a viziona fişierele în foldere. 
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Video

Redarea fişierelor video 

Din meniul principal, selectaţi     pentru a intra 
în modul video. 

Navigaţi prin sub-meniuri pentru a selecta 
fişierul video. 

Apăsaţi pe      pentru a porni sau întrerupe 
redarea. 

Apăsaţi pe       pentru a afişa mai multe 
opţiuni. 
Apăsaţi pe        pentru a trece la nivelul 
anterior. 
Ţineţi apăsat pe        pentru a trece la 
meniul principal. 

Navigarea în interiorul unui 
fişier video 

În timp ce redaţi fişierul video, apăsaţi pe 
pentru a derula înainte/înapoi în interiorul 

fişierului. 
Apăsaţi pe      pentru a afişa mai multe 
opţiuni. 

Ştergerea fişierului video 
curent 

Mai jos este prezentat modul de ştergere al 
fişierului video curent. 

În timp ce fişierul video este redat, apăsaţi pe 

Selectaţi opţiunea pentru ştergere. 

Selectaţi [Yes] pentru a confirma ştergerea. 

Ştergerea mai multor fişiere  
video 

Folosiţi software-ul Philips Songbird pentru a 
sincroniza fişierele media. Alternativ, puteţi 
şterge fişierele în Windows Explorer. 

Conectaţi player-ul la calculator. 

În Windows Explorer, localizaţi folder-ul 
VIBE. 

Ştergeţi fişierele în acelaşi mod cum ştergeţi 
fişierele din calculator. 

Notă 

Alternativ, puteţi selecta     din meniul principal 
pentru a viziona fişierele în foldere. 
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Imagini 

Adăugarea imaginilor 

Conectaţi player-ul VIBE la calculator. 

În Windows Explorer, creaţi foldere în player-ul 
VIBE. 

Copiaţi fişierele şi sortaţi-le în funcţie de foldere. 

Vizionarea imaginilor 

Din meniul principal, selectaţi      pentru a 
intra în modul Imagine. 

Navigaţi prin sub-meniuri pentru a selecta o 
imagine. 

Apăsaţi pe      pentru a viziona imaginea în 
modul Full Screen. 

Apăsaţi pe                  pentru a roti imaginea. 
Apăsaţi pe       pentru a afişa mai multe 
opţiuni. 
Apăsaţi pe        pentru a trece la nivelul 
anterior. 
Ţineţi apăsat pe        pentru a trece la 
meniul principal. 

Pornirea slideshow-ului 

În timp ce vizionaţi imaginile în modul full 
screen, apăsaţi pe       pentru a porni 
slideshow-ul. 
Apăsaţi pe       pentru a viziona mai multe 
opţiuni. 

Ştergerea imaginii curente 

Mai jos este prezentat modul de ştergere a 
imaginii curente. 

În timp ce vizionaţi imaginea în modul full 
screen, apăsaţi pe 

Selectaţi opţiunea de ştergere. 

Selectaţi [Yes] pentru a confirma ştergerea. 

Ştergerea mai multor imagini 
Folosiţi calculatorul pentru a şterge imaginile cu 
Windows Explorer. 

Conectaţi player-ul VIBE la calculator. 

În Windows Explorer, localizaţi imaginile din 
player. 

Ştergeţi imaginile în acelaşi mod ca şi cum aţi 
şterge imaginile de pe calculator. 

Notă 

Alternativ, puteţi selecta     din meniul principal 
pentru a viziona fişierele în foldere. 
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Radio 

A asculta la radio 

Din meniul principal, selectaţi       pentru a 
intra în modul radio. 

Cablul pentru căşti are scopul de 
antena FM. 

Sfat 

Redarea de la radio se va opri cînd selectaţi altă 
sursă de redare sau cînd opriţi player-ul. 

Căutarea manuală 

În modul      , puteţi căuta manual posturile 
de radio: 

Pentru a căuta postul de radio următor, 
ţineţi apăsat pe 

Pentru a îmbunătăţi frecvenţa, apăsaţi 
scurt pe 

Căutarea automată 
Opţiunea de căutare automată vă ajută să 
găsiţi şi să salvaţi posturile de radio. 

În modul      cu căştile conectate, selectaţi o 
presetare. 

Apăsaţi pe       şi selectaţi [Auto tune]. 

Dacă sunteţi rugaţi, selectaţi [Yes] pentru 
confirmare. 

Radioul va căuta şi salva posturile de radio 
cu semnal puternic. Puteţi salva pînă la 20 
de posturi de radio. 

Pentru a opri căutarea, apăsaţi pe 
Pentru a trece la meniul principal, ţineţi 
apăsat pe        pentru 2 secunde. 

Redarea unui post presetat 

În modul      , selectaţi o presetare. 

Apăsaţi pe      sau pe      pentru a schimba 
postul de radio. 

Pentru a căuta postul următor, ţineţi apăsat 
pe      sau pe        pentru 2 secunde. 

Pentru a trece la meniul principal, ţineţi 
apăsat pe        pentru 2 secunde. 

Notă 

Pentru a reda un post presetat, mai intîi trebuie să 
salvaţi posturile de radio. 
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A asculta la înregistrări 

Pentru a asculta înregistrările radio*: 

Din meniul principal, selectaţi 

Apăsaţi pe       şi selectaţi [Recordings library] >
[FM radio]. 

Selectaţi o înregistrare. 

Apăsaţi pe       pentru a reda înregistrarea. 

Notă 

*Înregistrarea FM radio este disponibilă doar 
pentru anumite versiuni. Consultaţi informaţiile 
din meniul VIBE pentru a afla ce caractersitici sunt 
disponibile. 

Pentru a asculta la înregistrarile audio/de voce: 

Din meniul principal, selectaţi 

Apăsaţi pe       şi apoi selectaţi [Recordings 
Library] > [Voice]. 

Selectaţi o înregistrare. 

Apăsaţi pe       pentru a reda înregistrarea. 

Încărcarea înregistrărilor 
pe calculator 

Folosiţi software-ul Philips Songbird pentru a 
sincroniza fişierele media. Alternativ, puteţi 
transfera înregistrările cu Windows Explorer. 

Conectaţi player-ul la calculator. 

În Windows Explorer, deschideţi VIBE. 

Selectaţi folder-ul Recordings > Voice sau 
FM radio*. 

Copiaţi înregistrările către locaţia dorită din 
calculator. 

Notă 

*Înregistrarea FM radio este disponibilă doar 
pentru anumite versiuni. Consultaţi informaţiile 
din meniul VIBE pentru a afla ce caractersitici sunt 
disponibile. 



23

1

2
3
»

11

1 .
2

3
4  

»

Înregistrarea 

Înregistrarea de la radio FM 
(opţiune disponibilă doar 
pentru anumite versiuni!) 

Din meniul principal, selectaţi 

Apăsaţi pe       şi selectaţi [Start FM radio 
recording]. 

Apăsaţi pe     pentru a porni sau 
întrerupe înregistrarea. 

Apăsaţi pe       pentru oprire. 

Apăsaţi pe     pentru a salva înregistrarea sau 
apăsaţi pe       pentru anulare. 

Înregistrările sunt salvate pe player. 
(Formatul numelui fişierului: FMRECXXX.
MP3, unde XXX este numele înregistrării 
care este generat automat). 

Sfat 

Înregistrările se găsesc în [Recordings Library] > 
[FM Radio]. 

Înregistrarea audio/a vocii 

Mai jos este prezentat modul de înregistrare 
audio/a vocii cu ajutorul microfonului încor-
porat. 

Din meniul principal, selectaţi      > [Start 
voice recording]. 

Apăsaţi pe     pentru a porni sau 
întrerupe înregistrarea. 

Apăsaţi pe      pentru oprire. 

Apăsaţi pe      pentru a salva înregistrarea sau 
apăsaţi pe       pentru anulare. 

Înregistrările sunt salvate pe player. 
(Formatul numelui fişierului: VOICEXXX.
MP3, unde XXX este numele înregistrării 
care este generat automat). 

Sfat 

Înregistrările se găsesc în [Recordings Library] > 
[Voice]. 
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Ştergerea înregistrării curente 

Mai jos este prezentată modalitatea de ştergere
a înregistrării curente. 

În timp ce ascultaţi o înregistrare, apăsaţi pe 

Selectaţi opţiunea de ştergere.  

Selectaţi [Yes] pentru confirmare. 

Ştergerea mai multor 
înregistrări 

Mai jos este prezentată modalitatea de ştergere
a înregistrărilor în Windows Explorer. 

Conectaţi player-ul la calculator. 

În Windows Explorer, localizaţi folder-ul 
Recordings > Voice sau FM radio*. 

Ştergeţi înregistrările în acelaşi mod cum 
ştergeţi fişierele de pe calculator. 

Notă 

*Înregistrarea FM radio este disponibilă doar 
pentru anumite versiuni. Consultaţi informaţiile 
din meniul VIBE pentru a afla ce caractersitici sunt 
disponibile. 
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Folosirea player-ului 
pentru stocare şi transfer 

Mai jos este prezentat modul de stocare şi 
transfer al fişierelor cu ajutorul player-ului VIBE. 

Conectaţi player-ul VIBE la calculator. 

Din calculator, în Windows Explorer, copiaţi 
fişierele către player. 

Sfat 

Folosiţi calculatorul pentru transfer, ştergere sau 
stocare de fişiere pe player-ul VIBE. 
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Play mode Play music from... All songs
...this album
...this artist

Repeat Repeat off (default)
Repeat 1
Repeat all

Sound 
settings

FullSound Off (default)
On*

Equalizer Off (default) 
Rock
Funk
Hip hop

Jazz
Classical
Techno
Custom

Volume limit Off (default)
Set

Display 
settings

Theme Black (default)
Blue
Red

Screen off timer 15 sec. (default)
30 sec.
45 sec.
Always on

Sleep timer Time left: [x] minutes
Off (default)
Set

Setări 

Mai jos este prezentat modul în care puteţi 
personaliza player-ul VIBE. Din meniul principal, 
selectaţi       pentru a intra în modul de setare. 
În meniul      , navigaţi în modul următor: 

Apăsaţi pe              pentru a selecta o opţiune. 

Apăsaţi pe     pentru confirmarea selecţiei şi 
pentru a trece la nivelul următor (cînd este 
disponibil). 

Apăsaţi pe      pentru a trece la nivelul 
anterior. 
Ţineţi apăsat pe       pentru a ieşi din 
meniul 

În meniul      , următoarele opţiuni sunt disponibile: 

Setări            Meniul cu opţiuni                     Meniul cu sub-opţiuni 
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Settings Options menu Sub-options menu
Language Czech

Greek
English (default)
Danish
German
Spanish
French
Hungarian
Dutch

Italian
Norwegian
Polish
Portuguese
Portuguese (Brazilian)
Russian
Slovak
Finnish
Swedish

Turkish

Traditional Chinese
Japanese
Korean
Thai (some versions only)
Arabic (some versions 
only)
Hebrew (some versions 
only)

Information Capacity
Free space
Firmware version
Model
Support site

Factory 
settings

Restore factory settings? 
(Files are not affected.)

Yes
No

*Funcţia Equalizer se dezactivează cînd modul 
FullSound este selectat. 
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SA2VBE04 4GB NAND Flash
SA2VBE08 8GB NAND Flash
SA2VBE16 16GB NAND Flash

14

MP3:
MP3 bit rates: 8 - 320 kps and VBR
MP3 sample rates: 8, 11.025, 16, 22.050, 32, 
44.1, 48 kHz
WMA:
WMA bit rates: 5 - 320 kbps
WMA sample rates: 8, 11.025, 16, 22.050, 32, 
44.1, 48 kHz
WAV
FLAC
APE

MJPEG (in .mp4)
MP4

JPEG
BMP

Informaţii 
tehnice 

Alimentare 
Sursa de alimentare: baterie internă 
reîncarcabilă 250 mAh Li-ion polymer 
Timpul de redare1 
Muzică: 24 de ore 
Video: 4 ore 

Software 
Philips Songbird: pentru actualizarea 
firmware-ului şi transferul3 de muzică 

Conectivitate 
Căşti 3.5 mm 
USB 2.0 High speed 

Sunet 
Separarea canalelor: 45 dB 
Frecvenţa de răspuns: 80 - 18,000 Hz 
Ieşirea alimentării: 2 x 2.4 mW 
Raportul semnal-zgomot: > 84 dB 

Redarea audio 
Formate suportate: 

Redarea Video  
Formate suportate: 

Afişarea imaginilor 
Formate suportate 

Surse de stocare 
Capacitatea memoriei încorporate2: 

Afişaj  
Ecran LCD 128 x 128 pixels 

Note 

1Bateriile reîncărcabile au un număr limitat de 
cicluri de încărcare. Durata de folosire a bateriei şi 
nr. de cicluri de încărcare variază, în funcţie de 
setări şi utilizare. 
21GB = I milliard de biţi; capacitatea de stocare 
este mai mică. Capacitatea întreagă a memoriei 
nu este disponibilă doarece o parte a memoriei 
este rezervată pentru player. Capacitatea de 
stocare se bazează pe piese de 4 minute codate 
la 128 kbps. 
3Viteza de transfer depinde de sistemul de 
operare şi de configuraţia software-ului. 

Cerinţele sistemului 

Windows® XP (SP2 sau mai nou) / Vista / 7 
Procesor Pentium III 800 MHz sau mai mare 
512 MB RAM 
Spaţiu pe hard disk de 500 MB 
Conexiune la Internet 
Windows® Internet Explorer 6.0 sau mai nou 
CD-ROM drive 
Port USB 
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Glosar 

Bit rate 
Bit rate reprezintă numărul de biţi care sunt 
procesaţi pe unitate de timp. Bit rate este 
măsurat, de obicei, în mai mulţi biţi pe secundă 
(kilobiţi pe secundă: kbps). Termenul Bit rate este 
sinonim cu raportul tarnsferului de informaţii (sau 
mai simplu Data rate). 

Compresie 
În termeni audio, acesta este un proces, temporar 
sau permanent, care reduce informaţiile audio 
pentru stocarea şi transmisia mai eficientă. O 
reducere temporară a fişierului se numeşte 
compresie ‘non-lossy’, şi nici o informaţie nu este 
pierdută. O reducere permanentă a fişierului 
(precum fişierele MP3) se numeşte compresie 
“lossy”, şi implică piederea informaţiilor inutile
(acestea nu se mai pot recupera). 

Decibeli (dB) 
O unitate de măsură folosită pentru a exprima 
diferenţa relativă dintre energia şi intensitatea 
sunetului. 

FM (Frecventa de modulaţie) 
În transmisiile radio: o metodă de modulaţie în 
care frecvenţa voltajului de transport variază cu 
frecvenţa voltajului de modulaţie. 

Frecvenţa de răspuns 
Reprezintă raza frecvenţelor pe care boxa le 
reproduce, de la cea mai mică frecvenţă pînă la 
cea mai mare. În timp ce frecvenţa optimă şi 
normală este de 20-20,000 Hz (Hertz), raza 
auzului uman este mult mai restricţionată. Un 
sistem de boxe bun va reproduce cît mai mult 
posibil din aceasta rază pentru a acoperi toate 
variaţiile. Driverele individuale sunt limitate la 
reproducerea doar a unui spectrum pentru care 
au fost fabricate, astfel încît răspunsul lor este 
limitat, dar reprezintă un punct necesar pentru 
sistemul de boxe. 

FullSound 
FullSound™ este o tehnologie inovativă 
dezvoltată de către Philips. FullSound™ 
reproduce identic detaliile audio ale fişierelor 
compresate, îmbunătăţind experienţa audio, fără 
distorsiuni. 

LCD (Liquid Crystal Display) 
Probabil, cel mai comun mod de a prezenta 
informaţiile vizuale pe echipamete electronice 
non-calculatoare. 

Compresie Lossless 
Un sistem pentru reducerea numărului de biti 
(densitate) dintr-un semnal audio fără a corupe 
semnalul original. 

MP3 
Un format de fişier cu un sistem de compresie 
audio. MP3 este abrevierea de la Motion Picture 
Experts Group 1 (sau MPEG-1) Audio layer 3.  
Cu formatul MP3, un CD-R sau CD-RW poate 
conţine de 10 ori mai multe informaţie decît un 
disc normal. 
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MSC [Mass Storage Class] 
Dispozitivul USB mass storage (USB MSC sau 
UMS) reprezintă un set de protocoale de 
comunicare care oferă o interfaţă dispozitivelor 
de stocare. Dispozitivele care suportă acest 
standard se numesc dispozitive MSC (Mass 
Storage Class). 
MTP [Media Transfer Protocol] 
Media Transfer Protocol suportă transferul 
fişierelor audio sau video către playere audio şi 
video portabile. 

Rip (ripping) 
Folosind un program care “ia” fişierul digital audio 
de pe un disc compact şi îl transferă către hard 
disk-ul calculatorului. Integritatea informaţiilor este 
salvată, deoarece semnalul nu trece prin cardul de 
sunet al calculatorului, şi nu trebuie să fie 
tranformat în format analog. Tranferul digital către 
digital crează un fişier WAV care poate fi 
transformat în fişier MP3. 

SuperScroll 
SuperScroll™ este o opţiune de navigare cu taste 
cu dublă acţiune. SuperScroll™ permite accesul 
rapid la comenzi cînd navigaţi prin librarii mari. Cu 
cît ţineţi apăsat mai mult cu atît se va naviga mai 
repede prin meniuri. 
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